
 

             

 

State of Oklahoma  
Project ENCORE 
 
Exercise Guide: 
Human Capital Planning 
 

 

 

 

 

 

 

July 2014



 

 Page ii 

Table of Contents 
PSPB_Training .................................................................................................................. 1 

HCP ............................................................................................................................................. 1 
Position Budget Preparation ................................................................................................................... 1 

3.10 - Setting Preferences ................................................................................................................................... 1 
3.10B - Review the Position Employee Data ...................................................................................................... 4 
3.11 - Edit Position Details ............................................................................................................................... 15 
3.12 - Add a new Position................................................................................................................................. 45 
3.13 - Copy Position Data ................................................................................................................................. 51 
3.14 - Exclude a Position .................................................................................................................................. 58 
3.15 - Transfer a Position.................................................................................................................................. 63 
3.16 - Reverse Transfer .................................................................................................................................... 69 
3.17 - Delete position for specific Version ....................................................................................................... 74 
3.18 - Delete position Across all Versions ........................................................................................................ 77 
3.19 - Synchronize position properties ............................................................................................................. 82 
3.19B - View Position Employee and Department Assignments ...................................................................... 85 
3.20 - Manage Position Employee Assignments............................................................................................... 96 
3.21 - Find and Assign Defaults ....................................................................................................................... 99 
3.22 - Calculate Compensation Budgets ......................................................................................................... 112 
3.23 - Allocate Compensation to General Ledger Accounts ........................................................................... 120 
3.24 - Review Position Budget ....................................................................................................................... 122 
3.25 - Review Employee Budget .................................................................................................................... 124 
3.26 - Review Element Budget ....................................................................................................................... 126 
3.27 - Review FTE Assignments .................................................................................................................... 128 
3.28 - Manage Approvals ............................................................................................................................... 129 

Position Budget Reviewer .................................................................................................................. 139 
3.29 - Setting Preferences ............................................................................................................................... 139 
3.30 - Mass update of Element Values for Positions and Employees ............................................................. 142 
3.31 - Mass update of the Allocation Percentage for Positions and Employees ............................................. 164 
3.32 - Mass Update of Allocation Percentage for a combination of Segments ............................................... 170 
3.33 - Manage Position Approval by Entity ................................................................................................... 175 
3.34 - Manage Approvals ............................................................................................................................... 178 

 



 

 Page 1 

PSPB_Training 

HCP 

Position Budget Preparation 

3.10 - Setting Preferences 
In this topic you will open the SOKPLAN application upon subsequent logons.   
User will also have the correct base dimensions set to Budget, Agency (Agency Request), FY16, 
and Current Service Level. 
 

Procedure 
 
 

 
 

Step Action 
1. To begin using the application, we must first Log On. 

 
The user name is not case-sensitive. 
 
Enter the desired information into the field. Enter "<User Name>". 

2. Enter the desired information into the field. Enter "<Password>". 
3. Click the Log On button. 
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Step Action 
4. Click the File menu. 

 
5. Click the Preferences... menu. 

 
6. Click the Content list. 

 
7. Click the Application list item. 
8. Click the Application: list. 

 
9. Click the Planning list item. 
10. Click the SOKPLAN list item. 

 
11. Click the OK button. 

 
12. Click the File menu. 

 
13. Click the Log Off menu. 

 
14. Click the Yes button. 

 
15. Log In again 

 
Enter the desired information into the field. Enter "Password". 

16. Click the Log On button. 

 
17. Navigate to the bottom left of the page 

 
Click the Preferences Expand button. 

 
18. Click the User Variable Options tab. 

 
19. Navigate to the "Selected Member" column (contains a field and button) 

 
Click the Scenario Member Selector button. 

 
20. Click the Budget list item. 

 
21. Click the Add button. 
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Step Action 
22. Click the OK button. 

 
23. Navigate to the "Selected Member" column (contains a field and button) 

 
Click the Version Member Selector button. 

 
24. Click the Agency list item. 

 
25. Click the Add button. 

 
26. Click the OK button. 

 
27. Navigate to the "Selected Member" column (contains a field and button) 

 
Click the Year Member Selector button. 

 
28. Click the All Years Expand button. 

 
29. Click the FY16 list item. 

 
30. Click the Add button. 

 
31. Click the OK button. 

 
32. Navigate to the "Selected Member" column (contains a field and button) 

 
Click the Request Member Selector button. 

 
33. Click the Total Request Expand button. 

 
34. Click the Current Service Level list item. 

 
35. Click the Add button. 

 
36. Click the OK button. 

 
37. Click the Save button. 
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Step Action 
38. User Preferences have been saved. 

 
Click the OK button. 

 
39. Navigate to the view pane 

 
Click the My Task List Expand button. 

 
40.  

End of Procedure. 

3.10B - Review the Position Employee Data 
In this topic you will review all positions and employees pre-loaded for a specific department.   
Other elements, i.e. benefits, taxes, additional earnings, and allocations, will be reviewed. 
 

Procedure 
 
 

 
 

Step Action 
1. Click the Position Budget Preparation Action button. 
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Step Action 
2. Locate the Entity field under the "Position's Employee Assignments" tab 

 
Click the Entity dropdown button to activate the menu. 

 
3. E.g.: 

 
Click in the 22000_1000001 - District Attorneys field. 

 
4. Click the Go button. 

 
5. Right-click any of the positions 

 
Right-click the Positon object. 

 
6. Click the View Position Details list item. 

 
7. Click the View Salary Grades list item. 

 
 

 
 

Step Action 
8. Review Salary Grade information 

 



 

 Page 6 

 
 

Step Action 
9. Click the View Position and Employee Assignments link. 

 
10. E.g.: 

 
Right-click in the EP22000041 - Assistant District Attorney field. 

 
11. Click the View Position Details list item. 

 
12. Click the View Additional Earnings list item. 
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Step Action 
13. Review Additional Earnings information (if any) 
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Step Action 
14. Click the View Position and Employee Assignments link. 

 
15. E.g.: 

 
Right-click in the EP22000044 - Assist District Attorney, Firs field. 

 
16. Click in the View Position Details field. 

 
17. Click in the View Benefits field. 

 
 

 
 

Step Action 
18. Review Benefits information (if any) 
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Step Action 
19. Click the View Position and Employee Assignments link. 
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Step Action 
20. Right-click any of the positions 

 
Right-click in the Any Position field. 

 
21. Click in the View Position Details field. 

 
22. Click in the View Taxes field. 

 
 

 
 

Step Action 
23. Review View Taxes information (if any) 
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Step Action 
24. Click the View Position and Employee Assignments link. 

 
 

 
 



 

 Page 12 

Step Action 
25. E.g.: 

 
Right-click the EP22000044 - Assist District Attorney, Firs object. 

 
26. Click the View Position Details menu. 

 
27. Click the View Allocations menu. 

 
 

 
 

Step Action 
28. -Expand the columns as necessary  

-Review the allocation data 
29. Review Allocation information (if any) 
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Step Action 
30. Click the View Position and Employee Assignments link. 

 
31. Click the Employee's Position Assignments tab. 

 
32. Click the Employee dropdown button to activate the menu. 

 
33. [NOTE: Please note that Users will be able to view all the State employees in the 

dropdown list but will be able to view data only for their agency users. Agency data 
is limited to the agency users only in this form. 
 
Users can use this form to review all the positions and departments; the selected 
employee has been assigned to, during the current budget cycle.] 
 
Enter the desired information into the Member field. Enter "EE117364". 

34. E.g.: 
 
Click the EE117364 - Lafferty, Allison M cell. 

 
35. Click the Go button. 
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Step Action 
36. -Use the horizontal scroll bar to scroll to the right of the page 
37. -Review the Employee Assignments 
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Step Action 
38. Complete the "Review the Position Employee Data" Task 

 
Click the Complete option. 

39. Click the Task List Home button. 
 

40.  
End of Procedure. 

3.11 - Edit Position Details 
In this topic you will update salary grades, additional earnings, benefits, and allocations for a 
position. 
You will review tax information. 
A to-be-hired employee will be assigned to a position.  
An employee will be successfully transferred out, transferred in, and a transfer will be reversed. 

Procedure 
 
 

 
 

Step Action 
1. Click the Mange All Positions Action button. 
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Step Action 
2. Manage All Positions:  

Entity should already be selected, if not please: 
-Select Entity in Page as < Select Desired DEptID> for example: 22000_1000001 
 
Once you click on Go: the form will display all the positions, filled as well as vacant 
in the form. 
Unlike, Review the position Employee Data that shows only filled positions. 

 
3. Use the vertical Scroll Bar to navigate to any position. 

 
E.g.: 
 
EP22000075 - Assistant District Attorney 
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Step Action 
4. Right-click a position 

 
E.g.: 
 
Right-click the Position 8 object. 

 
5. Click the Edit Position Details menu. 

 
6. Click the Salary Grades tab. 

 
7. Right-click the Row Header object. 

 
8. Click the Add Salary Information list item. 
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Step Action 
9. Add Salary Information 

-Enter/Select values for all the fields: 
Select Salary Grade: CLAS-A 
Select Grade Step: Communications Dispatcher - Step 1 
Enter Effective Start Date: 1/1/14 
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Step Action 
10. Enter the desired information into the *Select Salary Grade field. Enter "CLAS-

A". 
11. Enter the desired information into the *Enter Effective Start Date field. Enter 

"1/1/14". 
12. Click the Add button. 

 
13. A message appears reading "AddSalElement was successful" 

 
Click the OK button. 

 
14. Click the Additional Earnings tab. 

 
15. Right-click the Row Header row header. 

 
16. Click the Add Additional Earnings list item. 

 
 



 

 Page 20 

 
 

Step Action 
17. Add Additional Earnings 

-Enter/Select values for all the fields 
Select Additional Earnings: SRTS 
Select Option: Self Only 
Enter Effective Start Date: 1/1/15 
-Click the "Add" button 
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Step Action 
18. Enter the desired information into the *Select Additional Earning Element field. 

Enter "SRTS". 
19. Click the Select Option list. 
20. Click the Self Only list item. 
21. Enter the desired information into the *Enter Effective Start Date field. Enter 

"1/1/15". 
22. Click the Add button. 

 
23. A message displays reading: "AddAdditionalEarning was successful" 

 
Click the OK button. 
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Step Action 
24. Use the horizontal scroll bar to scroll to the end of the form 
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Step Action 
25. Click the Benefits tab. 

 
26. Right-click the Row Header object. 

 
27. Click the Add Benefit menu. 

 
 

 
 

Step Action 
28. Verify that "BEA" is selected benefit element 
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Step Action 
29. Click the Select Option list. 
30. Click the Plus Spouse list item. 
31. Enter the desired information into the *Enter Effective Start Date field. Enter 

"1/1/15". 
32. Click the Add button. 

 
33. A message displays reading "AddBenefitElement was successful." 

 
Click the OK button. 

 
34. Click the Tax Details tab. 
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Step Action 
35. Review the tax details 
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Step Action 
36. Click the Allocations tab. 

 
37. Right-click the Row Header object. 

 
38. Click the Add Allocation Information menu. 

 
 

 
 

Step Action 
39. Provide Allocations 

-Enter/Select values for all the fields 
Enter Effective Start Date: 1/1/15 
Enter Effective End Date: Leave Blank 
Allocation Type:  Percentage Allocation Assignments 
Enter Allocated Percentage: 20 
Enter Allocated Flat Amount: Leave Blank 
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Step Action 
40. Enter the desired information into the *Enter Effective Start Date field. Enter 

"1/1/15". 
41. Enter the desired information into the Enter Allocation Percentage field. Enter 

"20". 
42. Click the Add button. 

 
43. A message displays reading:"AddDistribution was successful." 

 
Click the OK button. 

 
44. Click the Account Segment SmartList button. 

 
45. Enter the desired information into the Member field. Enter "5111". 
46. E.g.: 

 
Click the 511110 - Sals-Regular Pay cell. 

 
47. Click the Fund Segment SmartList button. 

 
48. Enter the desired information into the Name field. Enter "22000_cf". 
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Step Action 
49. E.g.: 

 
Click the 22000_CF - Non Budgetary cell. 

 
50. Click the Program Segment SmartList button. 

 
51. Enter the desired information into the Name field. Enter "no_". 
52. Click the No_Program cell. 

 
53. Click the Project Segment SmartList button. 

 
54. Enter the desired information into the Name field. Enter "no_". 
55. E.g.: 

 
Click the No Project cell. 

 
56. Click the CFDA Segment SmartList button. 

 
57. Enter the desired information into the Name field. Enter "no_". 
58. Click the No_CFDA cell. 

 
59. Click the Operating Unit SmartList button. 

 
60. Enter the desired information into the Name field. Enter "no_". 
61. Click the No_OU cell. 

 
62. Click the Save button. 

 
63. A message displays reading: "The data has been saved." 

 
Click the OK button. 
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Step Action 
64. Use the horizontal scroll bar to scroll to the right 
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Step Action 
65. The total percentage allocation for all lines should be equal to 100 

 
If required, do the following: 
 
Enter the desired information into the Percentage Allocation for first Allocation 
field. Enter "80". 

66. Click the Save button. 

 
67. A message appears reading: "The data has been saved." 

 
Click the OK button. 

 
68. Click the FTE tab. 

 
69. Right-click the Row Header object. 

 
70. Click the Update FTE menu. 

 
71. Enter the desired information into the Enter FTE field. Enter ".5". 
72. Enter the desired information into the Enter Effective Start Date field. Enter 

"1/1/15". 
73. Click the Add button. 

 
74. A message displays reading "AddFTE was successful." 

 
Click the OK button. 

 
75. Click the Employee tab. 
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Step Action 
76. Review the employee details – you will see an employee if the selected position has 

employee assigned to it otherwise it will be blank.  
 
Do not assign more than one employee to the single incumbent position. 
You may assign more than one employee to a shared position. 
 
Note that Calculating compensation budget (step 150) updates the Status, FTE and 
approval status for a position or employee. Calculating compensation budget will 
also restrict you from assigning employee with more than "Position's proposed FTE" 
or assigning more than one employee to "single_incumbent positions". 
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Step Action 
77. Hide the View Pane (if not already hidden) 

 
Click the Collapse Pane button. 

 
78. Select the employee 

 
E.g.: 
 
Right-click the Employee 1 object. 

 
79. Click the Assign Employee menu. 

 
80. Click the Assign To-Be-Hired Employee menu. 
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Step Action 
81. Provide Assign-To-Be-Hired Employee Details 

-Enter/Select values for all the fields 
Enter Employee Number: 100001 
Enter Employee Name: Lynn Smith  
Enter Employee Type: Regular 
Select FT/PT: Full-Time 
Select Pay Type: Non-exempt 
Select Location Code: L02500_16 - Oklahoma Military Department 
Enter FTE: .5 
Enter Overtime Hours: Leave Blank 
Enter Hire Date: 10/15/92 
Is Replacement?: No 
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Step Action 
82. Enter the desired information into the Enter Employee Number field. Enter 

"EE100001". 
83. Enter the desired information into the *Enter Employee Name field. Enter "Lynn 

Smith". 
84. Click the *Select Employee Type list. 
85. Click the Regular list item. 
86. Click the *Select Pay Type list. 
87. Click the Non-exempt list item. 
88. *Select Location Code. 

 
In order to be able to select the location code in our agency. Click on the drop down 
button and type "L" and your agency number quickly. for example, type "L22000" 
to get to all location codes in your agency. 
Click the *Select Location Code list. 

89. Click the L02500_16 - Oklahoma Military Department list item. 
90. Enter the desired information into the *Enter FTE field. Enter ".5". 
91. Enter the desired information into the *Enter Hire Date field. Enter "10/15/92". 
92. Click the Assign button. 
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Step Action 
93. A message box displays reading: FillPosition was successful 

 
Click the OK button. 

 
94. E.g.: 

 
Right-click the Employee 1 object. 

 
95. Click the Transfer Employee menu. 

 
96. Click the Single-step Employee Transfer menu. 

 
97. A message appears reading "Do you want to transfer this employee assignment?" 

 
Click the OK button. 

 
 

 
 



 

 Page 36 

Step Action 
98. -Enter/Select values for all the fields 

Select Source Entity: < Select Desired DeptID> for example: 22000_1000001 
Select Source Position: for example: EP22000075 
Select Target Position: for Example: EP22000055 
Select Target Entity: < Select Desired DeptID> for example: 22000_1000001 
Enter Effective Date: 12/31/14 
 
[NOTE: Select the target position that exists in the target entity. Target entity 
should be the lowest level (Dept ID) of entity.] 
 

 

 
 

Step Action 
99. Enter the desired information into the *Select Target Position field. Enter 

"EP22000055". 
100. Enter the desired information into the *Enter Effective Date field. Enter 

"12/31/14". 
101. Click the Transfer button. 

 
102. A message appears reading "EmployeeTransfer was successful" 

 
Click the OK button. 
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Step Action 
103. Click the Manage All Positions link. 

 
104. E.g.: 

 
Right-click the Position row header. 

 
105. Click the Edit Position Details menu. 

 
106. Click the Employee tab. 

 
107. [NOTE: Make sure that you right click on the employee that you transferred out. 

The employee in the first prompt select employee will be the same employee, change 
the target position and change the target entity to desired values. Make sure that 
you select the lowest level for the entity.] 
 
Right-click the Employee 2 object. 

 
108. Click the Transfer Employee menu. 

 
109. Click the Transfer Out an Employee menu. 

 
110. A message appears reading "Do you want to transfer out this employee 

assignment?" 
 
Click the OK button. 

 
111. Enter the desired information into the *Enter Effective Date field. Enter "6/1/15". 
112. Click the Transfer Out button. 

 
113. A message appears reading "EmployeeTransferOut was successful." 

 
Click the OK button. 

 
114. Open the View Pane (if not already open) 

 
Click the Restore Pane button. 

 
115. Click the Manage Pending Transfers object. 
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Step Action 
116. Click the Collapse Pane button. 

 
117. Right-click the Employee 2 object. 

 
118. Click the Transfer In menu. 

 
 

 
 

Step Action 
119. -Select values for all the  

Select Employee: for example: EE140600 
Select Target Position, for example: EP22000047 
Select Target Entity: < Select Desired DeptID> for example:  22000_1000001 
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Step Action 
120. Enter the desired information into the Select Target Position field. Enter 

"EP22000047". 
121. Enter the desired information into the Select Target Entity field. Enter 

"22000_1000001". 
122. Click the Transfer In button. 

 
123. Click the Restore Pane button. 

 
124. Click the Manage All Positions object. 

 
125. Click the Collapse Pane button. 

 
126. Right-click the Position object. 

 
127. Click the Edit Position Details menu. 

 
128. Click the Employee tab. 
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Step Action 
129. -Verify that there are users, for example: EE163160, EE140600 

 
Right-click the Employee object. 

 
130. Click the Transfer Employee menu. 

 
131. Click the Transfer Out an Employee menu. 

 
132. A message displays reading: "Do you want to transfer out this employee 

assignment?" 
 
Click the OK button. 

 
133. Enter the desired information into the *Enter Effective Date field. Enter "5/1/15". 
134. Click the Transfer Out button. 

 
135. A message appears reading "EmployeeTransferOut was successful." 

 
Click the OK button. 

 
136. Click the Restore Pane button. 

 
137. Click the Manage Pending Transfers object. 

 
138. Right-click the Position row header. 

 
139. Click the Reverse Transfer menu. 

 
140. A message displays reading "Allocation details are specific to the entity and cannot 

be copied back.  Please enter allocations after reversing the transfer." 
 
Click the OK button. 
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Step Action 
141. -Enter/Select values for all the fields 

Select Source Entity: Generic Entity 
Select Source Position, for example: EP22000047 
Select Target Position, for example: EP22000047 
Select Target Entity, for example: 22000_1000001 
 
[NOTE: Please specify the target entity as the entity from which you transferred out 
the position. It should be the lowest level member of the entity. Enter a valid value 
e.g. "22000_1000001".] 
 
Enter the desired information into the Select Target Entity field. Enter 
"22000_1000001". 

142. Click the Transfer button. 
 

 

 
 

Step Action 
143. The selected Employee/Position transfer has been reversed 
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Step Action 
144. Click the Manage All Positions object. 

 
145. Click the Collapse Pane button. 
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Step Action 
146. Use Vertical Scroll Bar to scroll to the desired position 

 
E.g.: 
 
EP22000075 
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Step Action 
147. Right-click the Position object. 

 
148. Click the Edit Position Details menu. 

 
149. Navigate to the Row Header in the bottom form under the "Total Position" tab 

 
Right-click the Row Header object. 

 
150. Click the Calculate Compensation Expense menu. 

 
151. A message displays reading: "EmpDistElmCost was successful." 

 
Click the OK button. 
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Step Action 
152. Review Total Compensation Expenses 
153.  

 
 
End of Procedure. 

3.12 - Add a new Position 
In this topic you will add a new position. 
The new position will be reviewed to verify successful addition of position. 

Procedure 
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Step Action 
1. Navigate to the "Manage All Positions" Task 

 
Click the Manage All Positions Action button. 
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Step Action 

2. Add a New Position 
-Right-click any of the row headers in the form 
 
E.g.: 
 
Right-click the EP22000014 - Payroll Clerk I object. 

 
3. Click the Add Position menu. 

 
 

 
 

Step Action 
4. Provide Position Details 

-Enter/Select values for all the fields  
Enter Position Name: for example: Lead 
Enter Position Number: for example: EP220001 
Select Position Type: for example: Single Incumbent 
Select Job: for example: JC0006 
Enter FTE: for example: 1 
Enter Start Date: for example: 7/1/15 
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Step Action 
5. Enter the desired information into the *Enter Position Name field. Enter "Lead". 
6. Enter the desired information into the *Enter Position Number field. Enter 

"EP220001". 
7. Click the Select Position Type list. 
8. Click the Single Incumbent list item. 
9. Click the *Select Job list. 
10. Click the JC0009 - Utility Office Worker list item. 
11. Enter the desired information into the Enter FTE field. Enter "1". 
12. Enter the desired information into the Enter Start Date field. Enter "7/1/14". 
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Step Action 
13. Click the *Select Location Code list. 
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Step Action 
14. Click the L22000_1801 - District Attorney Office list. 
15. Click the Add button. 

 
16. A message appears reading: "AddNewPosition was successful" 

 
Click the OK button. 

 
 

 
 

Step Action 
17. Use the Scroll Bar to scroll to the bottom of the form and review the newly created 

position 

 
18. Review the newly created position 
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Step Action 
19. Click the Task List Home button. 

 
20.  

End of Procedure. 

3.13 - Copy Position Data 
In this topic you will successfully finish this script if the copy position business rule gives a 
success message. 
The copied data can be reviewed successfully. 

Procedure 
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Step Action 
1. Navigate to the "Manage All Positions" Task 

 
Click the Mange All Positions Action button. 
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Step Action 

2. Copy Position Data 
-Right-click anyone of the row headers in the form 
 
E.g.: 
 
Right-click the EP22000014 - Payroll Clerk I object. 

 
3. Click the Copy Position Data menu. 

 
 

 
 

Step Action 
4. Provide Position Details 

-Select a value in the "Select Source Position": for example: EP22000173 
-Select a value in the "Select Target Position": for example: EP22000172 
-Select "Yes" for Copy Position Properties, Copy Salary Elements, Copy Additional 
Earning Elements, Copy Benefits Elements, Copy Tax Elements, Copy Assignment 
Elements, Copy Allocation Elements 
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Step Action 
5. Enter the desired information into the *Select Source Position field. Enter 

"EP22000014". 
6. Choose a position that is within the same department 

 
Enter the desired information into the *Select Target Position field. Enter 
"EP22000072". 

7. Click the Copy button. 
 

8. A message appears reading:"CopyPosition" was successful 
 
Click the OK button. 
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Step Action 
9. Use the scroll bar to scroll to the position where the data was copied to 
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Step Action 
10. E.g.: 

 
Right-click the EP22000172 - Secretary II object. 

 
 

 
 

Step Action 
11. Click the Edit Position Details menu. 
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Step Action 
12. Click the Allocations tab. 
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Step Action 
13. Review that the data was copied over successfully 

 
[NOTE: If there are no allocations to review, go back to the previous step and click 
the "Tax Details" tab to review that data] 

 

 
 

Step Action 
14. Click the Task List Home button. 

 
15.  

End of Procedure. 

3.14 - Exclude a Position 
In this topic you will exclude a position from budgetary impact. 
The business rule “ExcludePos” gives a dialog box at success. 
 

Procedure 
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Step Action 
1. Navigate to the "Manage All Positions" Task 

 
Click the Manage All Positions Action button. 
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Step Action 

2. Use the Scroll Bar to navigate to desired position  
 
E.g.:  
 
EP22000177 - Assistant District Attorney 

 
 

 
 

Step Action 
3. E.g: 

 
Right-click the EP22000177 - Investigator I object. 

 
4. Click the Exclude Position from Budget menu. 

 
5. A message box appears reading: "Do you want to exclude this position form 

Budget?" 
 
Click the OK button. 
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Step Action 
6. Provide Position Details 

-Enter/Select a value for "Effective Start Date" field: for example: 1/1/15 
-Enter/Select a value for "Effective End Date" field (optional) 
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Step Action 

7. Enter the desired information into the *Enter Effective Start Date field. Enter 
"1/1/14". 

 

 
 

Step Action 
8. Leave the Enter Effective End Date field blank 
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Step Action 
9. Click the Exclude button. 

 
10. A message appears reading "ExcludePos was successful" 

 
Click the OK button. 

 
11. Click the Task List Home button. 

 
12.  

End of Procedure. 

3.15 - Transfer a Position 
In this topic you will transfer the newly created position to a different department. 
Tester can review the target department to verify the position was successfully transferred. 

Procedure 
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Step Action 
1. Click the Manage All Positions Action button. 
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Step Action 
2. Right-click any of the new positions created 

 
Right-click the New Position 1 object. 

 
3. Click the Single-step Position Transfer menu. 

 
4. A message box appears reading: "Do you want to transfer out this position?" 

 
Click the OK button. 

 
 

 
 

Step Action 
5. Provide the Position Transfer Details 

-Enter/Select values for all the fields 
Select Source Entity: for example: 22000_1000001 
Select Source Position: for example: New Position 1 
Select Target Position: for example: New Position 1 
Select Target Entity: for example: 22000_1000007 
Enter Effective Date: for example: 1/1/15 
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Step Action 
6. Enter the desired information into the *Select Target Entity field. Enter 

"22000_1000007". 
7. Enter Effective Date that is later than the Start Date 

 
Enter the desired information into the *Enter Effective Date field. Enter "1/1/15". 

8. Click the Transfer button. 
 

9. A message box appears reading "EmployeeTransfer was successful" 
 
Click the OK button. 
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Step Action 
10. Check that the Position Transferred 

 
Click the Entity dropdown button to activate the menu. 

 
11. -Select the Target Entity for which the position was transferred to: for example: 

22000_1000007 
 
Click the 22000_1000007 cell. 

 
12. Click the Go button. 
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Step Action 
13. The New Position 1 is found in the list of positions 
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Step Action 
14. Click the Task List Home button. 

 
15.  

End of Procedure. 

3.16 - Reverse Transfer 
In this topic you will reverse the previously transferred position to send it back to its original 
department. 
The original department will be reviewed to verify the reverse transfer was successful. 

Procedure 
 
 

 
 

Step Action 
1. Click the Manage All Positions Action button. 
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Step Action 
2. Use the scroll bar to scroll to the bottom of the page 
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Step Action 
3. Right-click the New Position 1 object. 

 
4. Click the Reverse Transfer menu. 

 
5. A message box appears reading "Allocation details are specific to the entity and 

cannot be copied back.  Please enter allocations after reversing the transfer." 
 
Click the OK button. 

 
 

 
 

Step Action 
6. Select Effective Date 

-Select/Enter appropriate values in the fields 
Select Source Entity: 22000_1000007 
Select Source Position: New Position 1 
Select Target Entity: 22000_1000001 
Select Target Position: New Position 1 
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Step Action 
7. Enter the desired information into the *Select Source Entity field. Enter 

"22000_1000007". 
8. Click the Transfer button. 

 
9. A message appears reading: "ReverseTransfer was successful" 

 
Click the OK button. 
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Step Action 
10. Check the Position Reverse Transferred 

-Select Entity from the page drop down: for example: 22000_1000007 
 
Click the Entity dropdown button to activate the menu. 

 
11. Click the 22000_1000007 - Jail Fees cell. 

 
12. Click the Go button. 
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Step Action 
13. New Position 1 is not present in the list of positions 

 
14.  

End of Procedure. 

3.17 - Delete position for specific Version 
In this topic you will delete the newly created position for this version only. (Version = Agency 
Request) 
The business rule “DeletePositionVrs” will give a successful message. 
 

Procedure 
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Step Action 
1. Use the Scroll Bar to scroll to the bottom of the page  
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Step Action 
2. Right-click the New Position 1 object. 

 
3. Click the Delete Position for Specific Version menu. 

 
4. A message box appears reading "Delete this position?" 

 
Click the OK button. 

 
 

 
 

Step Action 
5. A message appears reading: "DeletePositionVrs was successful" 

 
Click the OK button. 
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Step Action 
6. Click the Task List Home button. 

 
7.  

End of Procedure. 

3.18 - Delete position Across all Versions 
In this topic you will create a new position. 
You will then delete this position from this and all other versions. (Agency Request,  Agency 
BWP). 
The business rule will give a success message, “DeletePosition was successful”. 
 

Procedure 
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Step Action 
1. Click the Manage All Positions Action button. 
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Step Action 
2. E.g.: 

 
Right-click the EP22000043 - Secretary II object. 

 
3. Click the Add Position menu. 

 
 

 
 

Step Action 
4. Provide Position Details 

-Enter/Select values for all the fields  
 
Enter Position Name: for example: Lead 
Enter Position Number: for example: EP220001 
Select Position Type: for example: Single Incumbent 
Select Job: for example: JC0006 
Enter FTE: for example: .5 
Enter Start Date: for example: 1/1/14 
Select Location Code: for example: L22000_1801 
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Step Action 
5. Click the Add button. 

 
6. A message appears confirming the add new position was successful 

 
Click the OK button. 
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Step Action 
7. Use the Scroll Bar to scroll to the bottom of the page to the newly created position 
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Step Action 
8. E.g.: 

 
Right-click the New Position 1 object. 

 
9. Click the Delete Position Across All Versions menu. 

 
10. A message box appears reading "Delete this position?" 

 
Click the OK button. 

 
11. A message appears reading: "DeletePosition was successful" 

 
Click the OK button. 

 
12. Click the Task List Home button. 

 
13.  

End of Procedure. 

3.19 - Synchronize position properties 
After making edits to the positions and employees, in this topic you will synchronize all the 
position properties as updated. 
The business rule will give a message, “PushProMasterData was successful”. 
 

Procedure 
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Step Action 
1. Click the Manage All Positions Action button. 
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Step Action 
2. Synchronize Position Properties 

-Right-click any of the row headers in the form 
 
e.g.: 
 
Right-click the EP22000014 - Payroll Clerk I object. 

 
3. Click the Synchronize Position Properties menu. 

 
 

 
 

Step Action 
4. A message appears reading: "PushPosMasterData was successful." 

 
Click the OK button. 
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Step Action 
5. Complete "Manage All Positions" Task 

 
Click the Complete option. 

6. Click the Task List Home button. 
 

7.  
End of Procedure. 

3.19B - View Position Employee and Department Assignments 
In this topic you will review the existing position split across departments. Select the desired 
position in the page drop down to view all the departments that the position belongs to. Position's 
FTE is split between the departments to allocate the compensation across all the listed 
departments. 

Procedure 
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Step Action 
1. Click the View Position Employee and Department Action button. 

 
2. Hide the View Pane (If not already hidden) 

 
Click the Collapse Pane button. 
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Step Action 
3. Scroll to the right of the page to review the data. 
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Step Action 
4. Right-click on the employee in the first row 

 
E.g. 
 
Right-click the Employee 1 object. 

 
5. Click the Edit Employee Details menu. 

 
6. Click the FTE tab. 

 
 

 
 

Step Action 
7. Note that FTE for the first department is .8 
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Step Action 
8. Click the Allocations tab. 
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Step Action 
9. Scroll to the right of the page to see the allocation percentage - 100% 
10. Note that the allocation percentage is 100% 

 

 
 

Step Action 
11. Click the View Position-Employee Assignments Across Entities link. 

 
12. Right-click on the employee in the second row 

 
E.g. 
 
Right-click the Employee 1 object. 

 
13. Click the Edit Employee Details menu. 

 
14. Click the FTE tab. 
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Step Action 
15. Note that FTE for the second department is .1 
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Step Action 
16. Click the Allocations tab. 

 
 

 
 

Step Action 
17. Scroll to the right of the form to review the allocation percentage - 100% 
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Step Action 
18. Click the View Position-Employee Assignments Across Entities link. 

 
19. Right-click on the employee in the third row 

 
E.g. 
 
Right-click the Employee 3 object. 

 
20. Click the Edit Employee Details menu. 

 
21. Click the FTE tab. 
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Step Action 
22. Note that FTE for the third department is .1 
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Step Action 
23. Click the Allocations tab. 

 
 

 
 

Step Action 
24. Scroll to the right of the form to review the allocation percentage. 

Note that the allocation percentage is 100% 
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Step Action 
25. Click the View Position-Employee Assignments Across Entities link. 

 
26. Click the Complete option. 
27. Click the Task List Home button. 

 
28.  

End of Procedure. 

3.20 - Manage Position Employee Assignments 
In this topic you will be able to review the positions / employees assignments and updated data 
for the current department. 

Procedure 
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Step Action 
1. Start "Manage Position-Employee Assignments" Task 

 
Click the Manage Position-Employee Assignments Action button. 
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Step Action 

2. -Review the position employee data for your entity. 
 
-Use the vertical scroll bar to navigate through the form 

 

 
 

Step Action 
3. Review the Position, e.g. : EP22000047 and check that employee, e.g.: EE140600 is 

assigned to it 
 
Click in the field. 

 
4. Complete the "Manage Position-Employee Assignments" Task 

 
Click the Complete option. 

 
5. Click the Task List Home button. 

 
6.  

End of Procedure. 
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3.21 - Find and Assign Defaults 
In this topic you will be able to find positions/employees and assign defaults based on criteria and 
position, for all compensation elements. 
You will see a message in the Operation Status column validating the success of the assignments. 

Procedure 
 
 

 
 

Step Action 
1. Start the "Find and Assign Defaults" Task 

 
Click the Find and Assign Defaults Action button. 

 
2. Right-click the Row Header cell. 

 
3. Click the Search menu. 

 
4. Click the Find Positions or Employees menu. 
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Step Action 
5. Use the filters to narrow down the search. If you want to get all the positions in a 

particular DeptID, press “Find” button without making any changes to any of the 
options. 
 
Select following values in order to retrieve all the positions and employees: 
-Enter/Select values for appropriate fields within the "Find Positions or Employees" 
tab 
Select Position Start Date, Hire Date or Adjustment Date: No Selection 
Select Operation: Leave Blank 
Enter Date: Leave Blank 
Select Position Type: All 
Select Employee Type: All 
Select Pay Type: All 
Select FT/PT: All 
Select Job: All 
Select Location Code: All 
Select Union Code: All 
Select Annual Salary Spread: All 
Select Approval Status: All 
Select Year for Approval Status: "No Year" 
Elements: "Unspecified Element" 
Salary Basis: All 
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Step Action 
6. Click the Find button. 
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Step Action 
7. A message appears reading: "EvaluateCriteria was successful." 

 
Click the OK button. 

 
8. Select 'No' for the Position / Employee you do not want to apply defaults to.  

 
[NOTE: “apply default” action applies the change to all position that has Yes in the 
Apply Defaults column in the form.] 
 
Click the Apply Defaults SmartList button. 

 
9. Click the No cell. 

 
10. Click the Apply Defaults cell. 

 
11. Press [Ctrl+C]. 
12. Click the Apply Defaults cell. 

 
 

 
 

Step Action 
13. Use the vertical scroll bar to scroll to the bottom of the page. 
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Step Action 
14. *Press and hold the [Shift] key and click on the Apply Defaults cell in the last row. 

 
Press the [Shift] key and click the Apply Defaults cell. 

 
15. *Right-click on Yes cell in the Apply Defaults column 

 
Right-click the Apply Defaults cell. 

 
16. Click the Edit->Paste menu. 

 
17. Click the File menu. 

 
18. Click the Save menu. 

 
19. Click the View menu. 

 
20. Click the Refresh menu. 

 
21. E.g.: 

 
Right-click the EP22000039 - Secretary II row header. 
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Step Action 
22. Click the Salary Grade Defaults->Overwrite Salary Grades menu. 

 
 

 
 

Step Action 
23. - Select the following Values: 

Select Salary Grade: "CLAS-A" 
Select Grade Step: Communication Dispatcher - Step 1 
Enter Effective Start Date: 1/1/15 
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Step Action 
24. Enter the desired information into the Enter Salary Grade field. Enter "CLAS-A". 
25. Enter the desired information into the Enter Effective Start Date field. Enter 

"1/1/15". 
26. Click the Run button. 

 
27. A message displays reading: "CriteriaOverWriteSalElement was successful." 

 
Click the OK button. 

 
28. E.g.: 

 
Right-click the EP22000039 - Secretary II row header. 

29. Click the Other Compensation Defaults menu. 

 
30. Click the Fill Other Compensation Elements menu. 

 
31. Enter the desired information into the Select Other Compensation Element field. 

Enter "SRTS". 
32. Click the Select Option list. 
33. Click the Self Only list item. 
34. Enter the desired information into the Enter Effective Date field. Enter "1/1/15". 
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Step Action 
35. Click the Run button. 

 
36. A message displays reading "CriteriaCreateMissingNonSalElement was successful." 

 
Click the OK button. 

 
37. E.g.: 

 
Right-click the EP22000039 - Secretary II row header. 

38. Click the View Position Details->View Salary Grades menu. 

 
 

 
 

Step Action 
39. Salary A is the new Grade type for the position. 
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Step Action 
40. Click the Find and Assign Defaults to Positions and Employees link. 

 
41. Right-click the Position row header. 
42. Click the View Position Details->View Additional Earnings menu. 
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Step Action 
43. SRTS is added to the additional earnings 
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Step Action 
44. Click the Find and Assign Defaults to Positions and Employees link. 

 
45. Right-click the Position object. 

 
46. Click the Allocation Defaults menu. 

 
47. Note: Please select “Overwrite with Default Allocations” if the position already has 

an allocation line in it.  
 
To check if the position has allocations defined or not – Go to: right click View 
Position Details-> View Allocations  
 
Click the Fill with Default Allocations menu. 

 
48. Enter the desired information into the Enter Effective Start Date field. Enter 

"1/1/15". 
49. Leave the 'Enter Effective End Date' as blank. 

 
Click the Run button. 

 
50. A message displays reading "CriteriaCreateMissingDistributions was successful." 

 
Click the OK button. 

 
51. E.g.: 

 
Right-click the EP22000037 - Data Processing Specialist row header. 

 
52. Click the View Position Details menu. 

 
53. Click the View Allocations menu. 
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Step Action 
54. Expand the Segment Columns as required to view the data. 
55. Review the default allocation that gets added to the employee/ position. 
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Step Action 
56. Click the Find and Assign Defaults to Positions and Employees link. 

 
57. E.g.: 

 
Right-click the EP22000039 - Secretary II row header. 

58. Click the Populate Annual Salary Spread Property menu. 

 
59. Click the Select Annual Salary Spread list. 
60. Click the 4-4-5 Calendar list item. 
61. Click the Fill button. 

 
62. A message displays reading "CriteriaCreateMissingDistributions was successful." 

 
Click the OK button. 

 
 

 
 

Step Action 
63. Use the horizontal scroll bar to scroll to the right of the form 
64. Review the Annual Salary Spread 
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Step Action 
65. Complete the "Find and Assign Defaults" Task 

 
Click the Complete option. 

66. Click the Next button. 
 

67.  
End of Procedure. 

3.22 - Calculate Compensation Budgets 
After making all desired updates in earlier scripts, in this topic you will set off the business rule to 
calculate the compensation budget amounts, for the current department. 
The Job Console will show the current job, and after refreshing by the tester, will show 
successfulness of the business rule. 

Procedure 
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Step Action 
1. If you had clicked "Next" on the previous script, you would end up on this page.  If 

you are not on this page, please launch the "Calculation Compensation Budgets" 
task  
 
Click the Launch button. 
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Step Action 
2. Enter/Review the values: 

Select Scenario: "Budget" 
Select Version: "Agency" 
Select Entity: "22000_1000001" 
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Step Action 

3. Click the Launch button. 
 

4. -In case, the Business Rule exceeds the timeout limit, an error message is displayed 
 
Click the OK button. 

 
5. Job Console is a console where users can view list of all the calculations launched 

by them. Users can also check the status of the calculations that exceeded the 
maximum time limit. 
 
Review the Job Console 
 
 
Click the Tools menu. 

 
6. Click the Job Console menu. 

 
7. Navigate to the "Status" field (bottom leftmost field) 

 
Click the Status list. 

 
8. Click the Status Processing list item. 

 
9. Click the Go button. 

 
10. Notice the rule is still running 

 
Try again after few minutes 
 
Click the Go button. 
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Step Action 
11. -The calculation has completed and the run status has changed to Completed 

 
-[NOTE: Perform steps 7-9 changing step 8 to "Completed" to view all the 
completed jobs] 
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Step Action 
12. Click the Status list. 

 
13. Click the Status Completed list item. 

 
14. Click the Go button. 

 
 

 
 

Step Action 
15. Use the vertical scroll to scroll to the bottom of the page 
16. -Verify that the Run Status for the job "EmpDistElmCost" is completed. 

 
-Click on "Completed" 
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Step Action 
17. Review the summary information for the rule that was ran 

 
Click the Close button. 

 
18. Unhide the View Pane (if it is currently hidden) 

 
Click the Restore Pane button. 

 
19. Click the Position Budget Preparation object. 
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Step Action 
20. Click the Calculate compensation budgets Action button. 
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Step Action 
21. Complete the "Calculate compensation budgets" Task 

 
Click the Complete option. 

22. Click the Task List Home button. 
 

23.  
End of Procedure. 

3.23 - Allocate Compensation to General Ledger Accounts 
After getting success in script 3.22, calculating compensation budgets, in this topic you will 
launch the business rule to allocate the budget amounts to the proper general ledger accounts, for 
the current department. 
The business rule returns “AllocDistCost Rule was run successfully”. 
 

Procedure 
 
 

 
 

Step Action 
1. Navigate to the "Allocate compensation to general ledger accounts" Task 

 
Click the Allocate compensation to general ledger accounts Action button. 
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Step Action 
2. Launch the business rule 

 
Click the Launch button. 

 
 

 
 

Step Action 
3. The flollwing fields should be prepopulated with data.  If not: 

 
Select Values 
-Enter the following values:  
Select Scenario: Budget  
Select Version: Agency 
Select Entity, e.g.: 22000_1000001 
Select Employee: Total Employees 
Select Position: All Positions 
-Click the "Launch" button 
 

4. Review "Budget" is entered for the Select Scenario field (if not entered, enter it now) 
 

5. Review "Agency" is entered for the Select Version field (if not entered, enter it now) 
6. Review "Agency e.g. 22000_1000001" is entered for the Select Entity field (if not 

entered, enter it now) 
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Step Action 
7. Review "Total Employees" is entered for the Select Employee field (if not entered, 

enter it now) 
8. Review "All Positions" is entered for the Select Position field (if not entered, enter it 

now) 
 

 
 

Step Action 
9. Click the Launch button. 

 
10. A message appears reading "AllocDistCost Rule was run successfully " 

 
Click the OK button. 

 
11. Complete the Allocate Compensation to General Ledger Accounts 

 
Click the Complete option. 

12. Click the Task List Home button. 
 

13.  
End of Procedure. 

3.24 - Review Position Budget 
In this topic you will be able to review the HCP data / budgets (for positions) by year, quarters. 
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Procedure 
 
 

 
 

Step Action 
1. Click the Review Position Budget Action button. 

 
2. Click the Collapse Pane button. 

 
3. View data at the "Year Total" summary level 

 
Click the Year Total Collapse button. 

 
4. In order to review the whole form, expand (if not already expanded) the "Year 

Total" column 
 
Click the Year Total Expand button. 

 
5. View data at by months by expanding the appropriate quarter 

 
-e.g. Q1 
 
Click the Q1 Expand button. 

 



 

 Page 124 

Step Action 
6. Complete "Review Position Budget" Task 

 
Click the Complete option. 

7. Click the Next button. 
 

8.  
End of Procedure. 

3.25 - Review Employee Budget 
In this topic you will be able to review the HCP data / budgets (for employees) by year, quarters. 

Procedure 
 
 

 
 

Step Action 
1. In order to review the whole form, expand (if not already expanded) the "Year 

Total" column 
 
Click the Year Total Expand button. 
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Step Action 
2. Review  form.  Use the scroll bar to navigate through the form. 
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Step Action 
3. Complete the "Review Employee Budget" Task 

 
Click the Complete option. 

4. Click the Next button. 
 

5.  
End of Procedure. 

3.26 - Review Element Budget 
In this topic you will be able to review the HCP data / budgets (for compensation elements) by 
year, quarters. 

Procedure 
 
 

 
 

Step Action 
1. In order to review the whole form, expand (if not already expanded) the "Year 

Total" column 
 
Click the Year Total Expand button. 
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Step Action 
2. Review form. Use the vertical scroll bar to navigate through the form. 
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Step Action 
3. Complete the "Review Element Budget" Task  

 
Click the Complete option. 

4. Click the Next button. 
 

5.  
End of Procedure. 

3.27 - Review FTE Assignments 
In this topic you will be able to review the HCP FTE numbers by position / employee. 

Procedure 
 
 

 
 

Step Action 
1. Review FTE Assignments form.  Use the scroll bar to navigate through the form. 
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Step Action 
2. Complete the "Review FTE Assignments" Task 

 
Click the Complete option. 

3. Click the Task List Home button. 
 

4.  
End of Procedure. 

3.28 - Manage Approvals 
In this topic you will be able to promote their department/division to the OMES Budget Division 
Approvers. 
A message dialog box displays with “Change Status Submitted” and the current owner changes 
for that department/division. 
 

Procedure 
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Step Action 
1. Navigate to the "Manage Approvals" task 

 
Click the Manage Approvals Action button. 
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Step Action 

2. Verify/Select the following: 
-Scenario: Budget 
-Version: Agency 
 
Click Go if selections are made 

 

 
 

Step Action 
3. Click the 22000_1000001 Planning Unit cell. 
4. Click the Actions menu. 

 
5. Click the Change Status menu. 
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Step Action 
6. Verify/Select "Promote" in the "Selection Action" list 
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Step Action 
7. Click the Select Next Owner list. 

 
8. Click the PUHShared_Grp_22000 list item. 

 
9. Enter the desired information into the field. Enter "Promoting the planning unit: 

Budget, Agency, 22000_1000001". 
10. Click the OK button. 

 
11. A message dialog box displays reading "Change Status Submitted" 

 
Click the OK button. 

 
12. Make sure that the "22000_1000001 Planning Unit" is selected (select if it is not) 

 
Navigate to the Actions Menu 
 
Click the Actions menu. 

 
13. Click the Refresh menu. 

 
 

 
 



 

 Page 134 

Step Action 
14. Review the "Location" cell corresponding to Planning Unit "22000_1000001".  The 

owner will now be the 5 digit agency 

 
 

 
 

Step Action 
15. Click the Actions menu. 

 
16. Click the Change Status menu. 
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Step Action 
17. Verify/Select "Promote" in the "Selection Action" list 
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Step Action 
18. Click the Select Next Owner list. 

 
19. Click the PUHShared_Grp_All_Agencies list item. 

 
20. Enter the desired information into the field. Enter "Promoting to All Agencies". 
21. Click the OK button. 

 
 

 
 

Step Action 
22. Message dialog box displays reading: "Change status submitted" 
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Step Action 
23. Click the Actions menu. 

 
24. Click the Refresh menu. 
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Step Action 
25. Review the "Location" cell corresponding to Planning Unit "22000_1000001".  The 

owner will now be the "All_Agencies" 
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Step Action 
26. Complete the "Manage Approvals" Task 

Click the Complete option. 
27. Click the Task List Home button. 

 
28. Click the Log Off object. 

 
 

 
 

Step Action 
29. Message dialog box displays reading: "Are you sure you want to log off?" 

 
30.  

End of Procedure. 

Position Budget Reviewer 

3.29 - Setting Preferences 
In this topic you will open the SOKPLAN application upon subsequent logons.   
User will also have the correct base dimensions set to Budget, Agency (Agency Request), FY16, 
and Current Service Level. 
 

Procedure 
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Step Action 
1. To begin using the application, we must first Log On. 

 
The user name is not case-sensitive 
 
Enter the desired information into the field. Enter "<User Name>". 

2. Enter the desired information into the field. Enter "<Password>". 
3. Click the Log On button. 

 
4. In order to open up the SOKPLAN application the following steps must be 

completed: 
 
Click the Navigate menu. 

 
5. Click the Applications menu. 

 
6. Click the Planning menu. 

 
7. Click the SOKPLAN menu. 
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Step Action 
8. Click the Preferences Expand button. 

 
9. Click the User Variable Options tab. 

 
10. Click the Scenario Member Selector button. 

 
11. Click the Budget list item. 

 
12. Click the Add button. 

 
13. Click the OK button. 

 
14. Click the Stage Member Selector graphic. 

 
15. Click the Agency list item. 

 
16. Click the Add button. 

 
17. Click the OK button. 

 
18. Click the Year of View button. 

 
19. Click the All Years Expand button. 

 
20. Click the FY16 list item. 

 
21. Click the Add button. 

 
22. Click the OK button. 

 
23. Click the Request Member Selector button. 

 
24. Click the Total Request Expand button. 

 
25. Click the Current Service Level list item. 

 
26. Click the Add button. 
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Step Action 
27. Click the OK button. 

 
28. Click the Save button. 

 
29. A message box displays reading "User Preferences have been saved." 

 
Click the OK button. 

 
30. Click the My Task List Expand button. 

 
31.  

End of Procedure. 

3.30 - Mass update of Element Values for Positions and Employees 
In this topic you will be able to find positions / employees and apply mass updates. 
You will see a message in the Operation Status column validating the success of the assignments. 
You will be able to increment salaries. 

Procedure 
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Step Action 
1. Click the Position Budget Reviewer Tasks Expand button. 

 
2. Click the Mass Update of Element Values for Position and Employees object. 

 
3. E.g.: 

 
Right-click the EP22000014 - Payroll Clerk I object. 

 
4. Click the Search menu. 

 
5. Click the Clear Criteria menu. 

 
6. A message appears reading "Clear Criteria was successful" 

 
Click the OK button. 

 
7. Right-click the row header. 

 
8. Click the Search menu. 

 
9. Click the Find Positions or Employees menu. 
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Step Action 
10. Select Values 

-Enter/Select values for appropriate fields within the "Find Positions or Employees" 
tab 
Select Position Start Date, Hire Date or Adjustment Date: for example: No Selection 
Select Operation: for example: Leave Blank 
Enter Date: for example: Leave Blank 
Select Position Type: for example: All 
Select Employee Type: for example: All 
Select Pay Type: for example: All 
Select FT/PT: for example: All 
Select Job: for example: All 
Select Location Code: for example: All 
Select Union Code: for example: All 
Select Annual Salary Spread: for example: All 
Select Approval Status: for example: All 
Select Year for Approval Status: for example: "No Year" 
Elements: for example: "Unspecified Element" 
Salary Basis: for example: All 
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Step Action 
11. Click the Find button. 

 
12. A message appears reading: "Evaluate Criteria was successful." 

 
Click the OK button. 
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Step Action 
13. Apply Defaults 

-Navigate to the "Apply Defaults" column on the "Find and Assign Defaults" page 
-Select "No" from the smart list in the "Apply Defaults" column for a range of 
Positions, for example: EP22000044:EP22001545 
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Step Action 
14. Navigate to a default for an appropriate employee in the "Apply Defaults" column 

 
Click the Apply Defaults SmartList button. 

 
15. Click the No list item. 

 
16. Click the Apply Defaults cell. 

 
17. Copy the content 

 
[NOTE: A "Allow Access" window may appear in which you click "Allow"] 
 
Press [Ctrl+C]. 
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Step Action 
18. Use the scroll bar to scroll to the bottom of the page selecting a range of cells 
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Step Action 
19. Navigate to the last cell in the Apply Defaults column 

 
Press the [Shift] key and click the Apply Defaults cell. 

 
20. Paste the contents 

 
Press [Ctrl+V]. 

 

 
 

Step Action 
21. Wait for the paste function to finish 
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Step Action 
22. Click the Save button. 
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Step Action 
23. Use the scroll bar to navigate to the top of the form 

 

 
 

Step Action 
24. E.g.: 

 
Right-click the EP22000014 - Payroll Clerk I row header. 

 
25. Click the Salary Increment menu. 

 
 



 

 Page 152 

 
 

Step Action 
26. -Enter/Select values for all the fields 

Increment Cycle Start Date: for example: No Selection 
Business Rule Start date: for example: 1/1/15 
Business Rule End Date: for example: 3/1/15 
Period: for example: Yearly 
Increment Frequency: for example: 1 
Select Operator: for example: Percentage Change 
Increment Value: for example: 10 
Start from first increment Cycle: for example: Yes 
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Step Action 
27. Click the Increment Cycle Date list. 
28. Click the No Selection list item. 
29. Enter the desired information into the Business Rule Start Date field. Enter 

"1/1/16". 
30. Enter the desired information into the Business Rule End Date field. Enter 

"3/1/16". 
31. Click the Period list. 
32. Click the Yearly list item. 
33. Enter the desired information into the Increment Frequency field. Enter "1". 
34. Click the Select Operator list. 
35. Click the Percent Change list item. 
36. Enter the desired information into the Increment Value field. Enter "10". 
37. Click the OK button. 

 
38. A message displays reading "AutoIncrementSal was successful" 

 
Click the OK button. 
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Step Action 
39. E.g.: 

 
Right-click the EP22000014 - Payroll Clerk I row header. 

 
40. Click the View Position Details menu. 

 
41. Click the View Salary Grades menu. 

 
 

 
 

Step Action 
42. Use Horizontal scroll bar to scroll to the right of the form 

 
43. Review the 3rd and 4th Element changes, the option end dates and the Override 

Option Value 
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Step Action 
44. Click the Mass Update of Element Values for Positions and Employees link. 

 
45. Select a Position 

 
E.g.: 
 
Right-click the EP22000014 - Payroll Clerk I row header. 

 
46. Click the Compensation Increment menu. 
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Step Action 
47. -Enter/Select values for all the fields 

Select Other Compensation Element: "SRTS" 
Increment Cycle Start Date: No Selection 
Business Rule Start Date: 8/4/16 
Business Rule End Date: 10/5/16 
Period: Monthly 
Increment Frequency: 1 
Select Operator: Add 
Increment Value: 5 
Start from First Increment Cycle: Yes 
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Step Action 
48. Enter the desired information into the Select Other Compensation Element field. 

Enter "SRTS". 
49. Click the Increment Cycle Start Date list. 
50. Click the No Selection list item. 
51. Enter the desired information into the Business Rule Start Date field. Enter 

"8/4/16". 
52. Enter the desired information into the Business Rule End Date field. Enter 

"10/5/16". 
53. Click the Period list. 
54. Click the Monthly list item. 
55. Enter the desired information into the Increment Frequency field. Enter "1". 
56. Click the Increment Frequency list. 
57. Click the Add list item. 
58. Enter the desired information into the Increment Value field. Enter "5". 
59. Click the OK button. 

 
60. A message displays reading "AutoIncrementNonSal was successful" 

 
Click the OK button. 
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Step Action 
61. E.g.: 

 
Right-click the EP22000015 - Grant Projects Monitor object. 

 
62. Click the View Position Details menu. 

 
63. Click the View Additional Earnings menu. 

 
 

 
 

Step Action 
64. Use the horizontal scroll bar to scroll to the right of the form 
65. Expand the columns to view all the data as necessary 

 
66. Review the 3rd, 4th and 5th Element changes, option end date and the override 

option value 
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Step Action 
67. Click the Mass Update of Element Values for Positions and Employees link. 

 
68. Right-click the EP22000015 - Grant Projects Monitor row header. 

 
69. Click the Increment to Next Step menu. 

 
 



 

 Page 160 

 
 

Step Action 
70. -Enter/Select values for all the fields 

Increment Cycle Start Date: Position Start Date 
Business Rule Start Date: 8/4/16 
Business Rule End Date: 10/5/16 
Period: Yearly 
Increment Frequency: 1 
Start from First Increment Cycle: Yes 
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Step Action 
71. Click the Increment Cycle Start Date list. 
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Step Action 
72. Click the Position Start Date list item. 
73. Enter the desired information into the Business Rule Start Date field. Enter 

"8/4/16". 
74. Enter the desired information into the Value field. Enter "10/5/16". 
75. Click in the Business Rule End Date field. 
76. Enter the desired information into the Increment Frequency field. Enter "1". 
77. Click the OK button. 

 
78. A message displays reading: "StepIncrement was successful." 

 
Click the Information object. 

 
79. E.g.: 

 
Right-click the EP22000039 - Secretary II row header. 

80. Click the Search menu. 

 
81. Click the Clear Criteria menu. 

 
82. A message displays reading: "Clear Criteria was successful." 

 
Click the OK button. 
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Step Action 
83. Notice that the search result has cleared 
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Step Action 
84. Complete "Mass Update of Element Values for Position and Employees" Task 

 
Click the Complete option. 

85. Click the Next button. 
 

86.  
End of Procedure. 

3.31 - Mass update of the Allocation Percentage for Positions and 
Employees 
In this topic you will be able to change allocation percentages and see the changes in the Total 
Compensation as per the updated percentage allocations. 

Procedure 
 
 

 
 

Step Action 
1. Hide the View Pane (if not already hidden) 

 
Click the Collapse Pane button. 
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Step Action 
2. Expand the columns (if necessary) to view all the data in the form 
3. Use the horizontal scroll bar to scroll to the right of the page to view the Total 

Compensation. 
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Step Action 
4. Click the SmartList button for Operating Unit Segment for the position: EP 

22000047, Employee: EE140600, Allocation Line:1st Allocation 
 
Click the Operating Unit SmartList button. 

 
5. E.g.: 

 
Enter the desired information into the Name field. Enter "22000_". 

6. Enter desired information 
 
E.G.: 
 
Click the 22000_11_NoPRD - District 11 cell. 

 
7. Click the Operating Unit Segment cell. 

 
8. Press [Ctrl+C]. 
9. Click the Operating Unit Segment cell for the position: EP 22000047, Employee: 

EE140600, Allocation Line:2nd Allocation 
 
Click the Operating Unit Segment cell. 

 
10. Press [Ctrl+V]. 
11. Click the Percentage Allocation cell for 1st Allocation 

 
Click the Percentage Allocation cell. 

 
12. Enter the desired information into the Percentage Allocation field. Enter "25". 
13. Enter the desired information into the Percentage Allocation field for 2nd 

Allocation. Enter a valid value e.g. "25". 
Click the Percentage Allocation cell. 

 
14. Enter the desired information into the Percentage Allocation field. Enter "75". 
15. Click the File menu. 

 
16. Click the Save menu. 
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Step Action 
17. Enter the values:  

Select Scenario: "Budget" 
Select Version: "Agency" 
Select Entity: "22000_1000001" 
Select Employee: "Total Employees" 
Select Position: "All Positions" 
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Step Action 
18. Enter the desired information into the Select Scenario field. Enter "Budget". 
19. Enter the desired information into the Select Version field. Enter "Agency". 
20. Click the Launch button. 
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Step Action 
21. Click on OK on the message that appears. 

Review the new Basic Salary Expense for the position:  EP 22000047 and  
Employee: EE140600 for the two allocation lines. 
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Step Action 
22. Click the Complete option. 
23. Click the Next button. 

 
24.  

End of Procedure. 

3.32 - Mass Update of Allocation Percentage for a combination of Segments 
In this topic you will change allocation percentages. 
You will review data to verify changes were successful. 

Procedure 
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Step Action 
1. Select the segments: 

-Select the entity for example: 22000_1000001 in the page 
-Enter the data in the form, for example: 
Fund Segment: "22000_19401 - GRF Duties" 
Program Segment: "No_Program" 
Project Segment: "No_Project" 
CFDA Segment: "No_CFDA" 
Operating Unit Segment: "22000_NoOPR_04" 
Percentage Allocation: 80 
 
Click the Fund Segment SmartList button. 

 
2. Enter the desired information into the Name field. Enter "22000_19401". 
3. Click the 22000_19401 - GRF - Duties cell. 

 
4. Click the Program Segment SmartList button. 

 
5. Enter the desired information into the Name field. Enter "no_". 
6. Click the No_Program cell. 

 
7. Click the Project Segment SmartList button. 

 
8. Enter the desired information into the Name field. Enter "no_". 
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Step Action 
9. Click the No_Project cell. 

 
10. Click the CFDA Segment SmartList button. 

 
11. Enter the desired information into the Name field. Enter "no_". 
12. Click the No_CFDA cell. 

 
13. Click the Operating Unit Segment SmartList button. 

 
14. Enter the desired information into the Name field. Enter "22000_25". 
15. Click the 22000_25_NoPRD - District 25 cell. 

 
16. Enter the desired information into the Percentage Allocation field. Enter "60". 
17. Click the File menu. 

 
18. Click the Save menu. 

 
19. A message appears reading: "The data has been saved." 

 
Click the OK button. 

 
20. Retrieve: 

 
Right-click the Rule Criteria row header. 

 
21. Click the Retrieve menu. 

 
22. Message appears reading "Mass Allocate was successful" 

 
Click the OK button. 
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Step Action 
23. Commit process: 

-Review the retrieved positions and employees 
-Right click any row in the second form 
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Step Action 
24. Click the Commit Mass Allocation menu. 

 
25. A message displays reading: "Commit was successful." is displayed 

 
Click the OK button. 

 
26. Click the Previous button. 

 
 

 
 

Step Action 
27. Review that the Employees EE129215, EE147866 have 2nd allocation and 1st 

allocation respectively. Percentage allocation has changed from 65 to 60  
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Step Action 
28. Click the Next button. 

 
29. Complete "Mass update of Allocation Percentage for a combination of segments" 

Task 
 
Click the Complete option. 

30. Click the Next button. 
 

31.  
End of Procedure. 

3.33 - Manage Position Approval by Entity 
In this topic you will approve new positions still awaiting approval. 
Tester will verify, on screen, that the new position now states “Approved”. 
 

Procedure 
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Step Action 
1. Use the vertical scroll bar to scroll through the form 

 
2. Use the horizontal scroll bar to scroll through the form 

 

 



 

 Page 177 

 
Step Action 

3. E.g.: 
 
Right-click the New Position 1 row header. 

 
4. Click the Approve menu. 

 
5. Enter the desired information into the Value field. Enter "FY16". 
6. Enter the desired information into the Comments field. Enter "Approved". 
7. Click the Confirm button. 

 
8. A message appears reading: "Approve was successful." 

 
Click the OK button. 

 
 

 
 

Step Action 
9. Use the vertical scroll bar to scroll to the bottom of the page 
10. Use the horizontal scroll bar to scroll to the right of the page 



 

 Page 178 

Step Action 
11. Review the Approval status has changed to the Approved. 

 
 

 
 

Step Action 
12. Click the Complete option. 
13. Click the Next button. 

 
14.  

End of Procedure. 

3.34 - Manage Approvals 
In this topic you will review each department/division –and approve/reject the planning unit. 

Procedure 
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Step Action 
1. Select the lowest level planning unit 

 
E.g.: 
 
Click the 22000_1000001 cell. 

2. Click the Actions menu. 

 
3. Click the Change Status menu. 

 
4. Click the Select Action list. 

 
5. Click the Approve list item. 

 
6. Click the Select Next Owner list. 

 
7. Click the <Automatic> list item. 

 
8. Enter the desired information into the field. Enter "Approving Planning Unit: 

Budget, Agency, 22000_1000001". 
9. Click the OK button. 
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Step Action 
10. Click the OK button. 

 
11. Review the Approval Status has changed to "Approved" 

Click the Approvals Status cell. 

 
12. Click the Complete option. 
13. Click the Task List Home button. 

 
14. Click the Collapse object. 
15. Click the Log Off object. 

 
16. Click the Yes button. 

 
17.  

End of Procedure. 
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